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Introduction 

This tutorial is designed for users who are beginning to process Vertical Seismic Profiling (VSP) 

data with RadExPro Professional. It guides you through the standard stages of basic VSP processing, 

from data input to building a subsurface velocity model and tying VSP data to seismic survey data. 

The tutorial assumes that you are already familiar with the fundamentals of the VSP method and 

the basic techniques used in VSP data processing. For detailed theoretical background on VSP and the 

processing procedures applied, refer to the following literature: 

Hardage B.A. Vertical Seismic Profiling: Principles, Pergamon, 2000 

All examples in this tutorial are based on real data, which can be downloaded from our website: 

http://radexpro.ru/upload/File/tutors/vsp/InData.zip 

The archive includes the following source data for processing: 

 Offset and zero-offset VSP seismograms in SEG-Y format (sp0_raw.sgy, sp1_raw.sgy) 

 Text files containing geometry (sp0_geom.txt, sp1_geom.txt) 

 Logging traces in LAS format (AK.las, RK.las) 

 A synthetic seismogram in SEG-Y format (seismic data.sgy) generated from logging data and 

used for VSP-to-seismic tie 

Additionally, you can download a completed project that contains the results of all steps 

described in this tutorial: http://radexpro.ru/upload/File/tutors/vsp/MyVSPProject.zip 

Please note that the program’s functionality extends beyond the modules described in this 

document. Detailed information on module parameters, as well as an overview of other features available 

in RadExPro, can be found in the RadExPro Professional User Manual, which is available for download 

from our website. 

http://radexpro.ru/upload/File/tutors/vsp/InData.zip
http://radexpro.ru/upload/File/tutors/vsp/MyVSPProject.zip


Input data 

The input data set includes the following files: 

 

Near Shot Point (SP): 

 sp0_geom.txt 

 sp0_raw.sgy 

 

Far Shot Point (SP): 

 sp1_geom.txt 

 sp1_raw.sgy 

 

Logging Data: 

 AK.las 

 RK.las 

 

Seismic Data: 

 seismic data.sgy 

 

Logging data files must follow a specific format: 

 The first line must begin with the symbol ~A. 

 This line must contain the DEPTH header (cable depths), followed by the headers of the 

logging curves. 

Creating a RadExPro Professional project 

All VSP data processing in RadExPro is carried out within projects. A project combines input 

data, intermediate results, final outputs, and processing flows into a single database managed by the 

RadExPro environment. 

Each project is stored in a separate directory on the computer’s file system. When a new project 

is created, its directory is generated automatically. Projects can be transferred between computers by 

simply copying the corresponding directory, provided that all required data are stored within it. 

Launch the Project Manager by clicking on the RadExPro desktop icon or Start Menu shortcut. 

Alternatively, you can launch the Project Manager by running Starter.exe from the program’s installation 

folder. If you did not create the desktop icon or Start Menu shortcut during installation, you can pin 

Starter.exe to the Quick Access Toolbar for easier access. 
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Launching the Project Manager opens a dialog box displaying the list of registered projects. 

 

Click Create New, then select the parent directory in the file system where the project 

subdirectory will be created. A dialog box will then prompt you to enter a project name. 
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Ensure that the Create subfolder option is selected, then click OK. A subdirectory with the same 

name as the project will be created in the chosen directory, and the project will be added to the list of 

available (registered) projects. 

 

Select the project and click OK. The main RadExPro window will open, displaying the project 

tree. At this stage, the tree is empty. 
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The main RadExPro window contains the following panels: 

 Project Tree – displays the structure of the current project. 

 Processing Flow – shows the active processing flow. 

 All Modules – lists all available processing modules. 

 Actions – displays a history of user actions. 

 Flow Status – shows the execution status of the processing flow. 

The RadExPro database has three structural levels: 

1. Project Area (upper level) 

2. Profile (middle level) 

3. Processing Flow (lower level) 

Each project can include multiple Areas. Each Area can include several Profiles, and each Profile 

can contain several Flows. 

By default, the Project Tree (located on the left side of the main window) contains one area with 

one profile and one processing flow: Area1 → Line1 → Flow1. 
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Right-click the name of an Area, Profile, or Flow to rename it, or press F2 as a shortcut. In this 

example, the area is renamed to My Borehole. 

 

 

Next, rename Line1 to match the name of the first shot point, SP0. 
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Finally, rename Flow1 to 010_data_load 

 

Because RadExPro Professional organizes the names of database elements alphabetically, it is 

recommended to number the flows to ensure they appear in a logically meaningful sequence. 

Zero-offset VSP processing 

The purpose of zero-offset VSP processing is to isolate the reflected P-wave field, create a 

velocity model and build a corridor stack trace. 

Click the 010_data_load flow in the project tree and observe the center and right panels of the 

main window. 
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On the right side of the screen, the All Modules panel displays a list of available processing 

modules, grouped by function: Data I/O (Data Input/Output), Geometry/Headers, Interactive Tools, 

Signal Processing, and others. 

The current flow is shown on the left in the Processing Flow window, which is initially empty. 

Processing modules will be added to this flow and executed in sequence. 

Data input into the project (010 – data load) 

We will create a flow consisting of the SEG-Y Input, Trace Output, and Screen Display modules. 

SEG-Y Input and Trace Output are located in the Data I/O group, Screen Display is located in the 

Interactive Tools group. 

This flow will read data from a SEG-Y file stored in the file system and save it to the project 

database as a dataset. 

Modules are added to the flow one at a time. To add a module to the flow, drag it from the library 

on the right to the Processing Flow area on the left. When a module is added, a Module Setup dialog box 

will open (you can also open this dialog later by double-clicking the module in the flow). Modules 

already in the flow can be repositioned by dragging them up or down. 

Find the SEG-Y Input module in the Data I/O group and add it to the flow. When you add the 

module, a dialog box will open, prompting you to specify the data reading parameters. To select the file, 

click on the File… button and select the sp0_raw.sgy data file. The parameters related to the file format 

will be filled in automatically. 
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After adding the SEG-Y Input module, add the Trace Output module. This module saves the data 

read by SEG-Y Input to the database. Name the database object sp0_raw and place it on the second 

database level in the SP0 profile. 

Note. Names of all database objects (seismic datasets, processing flows, etc.) should clearly reflect their content rather than 

being arbitrary combinations of letters. Seismic dataset names should consist of two parts: the source data identifier and the 

current processing stage. In this example, sp0_raw was chosen to represent the field data input stage. 

 

Advice: To prevent accidental overwriting of the sp0_raw dataset, comment out the Trace Output 

module after the first run. 

To monitor the flow execution, add the Screen Display module to the flow after Trace Output 

and configure its parameters as shown in the figure below. 
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The resulting flow should look like the following: 

 

To run the flow, select the Run ( ) menu command. The Screen Display window will open and 

show the input data as they are read from the file and saved to the database. The Screen Display window 
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should look like this: 

 

Note. If the dataset is very large (approaching or exceeding the installed RAM, or simply above 1 GB), use Framed Mode 

to read the data in smaller frames rather than loading it all at once. You can enable this mode and set the frame size via the 

Framed Mode option in the flow editor. 

Assigning geometry 

Assigning geometry to VSP data involves specifying a number of geometry-related values for 

each trace, which are then stored in the corresponding dataset header fields in the project database. The 

required values and their associated header fields are: 

 DEPTH – cable depth 

 SOU_ELEV – source absolute depth 

 SOU_X – source X coordinate 

 SOU_Y – source Y coordinate 

 REC_ELEV – receiver absolute depth 

 REC_X – receiver X coordinate 

 REC_Y – receiver Y coordinate 

 CHAN – channel number 



RadExPro seismic software    www.radexpro.com  

 

14 

 

Import of source and receiver position coordinates from a text file 

The Geometry Spreadsheet tool in RadExPro is used to manage seismic data header field values. 

It allows importing headers values from text tables.  

Select the Database/Geometry Spreadsheet menu item and choose the sp0_raw dataset. 

 

The figure below shows the Geometry Spreadsheet window. 
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Click the toolbar button  on the right to open the list of available headers. You can select 

headers and drag them into the table using the left mouse button. For more details on working with the 

Geometry Spreadsheet editor, see the RadExPro User Manual. 

Add the VSP geometry headers to the editor window. To do this, select the following headers 

from the list on the right (to select multiple headers, press and hold the Ctrl key): DEPTH (cable depth), 

SOU_X (source X coordinate), SOU_Y (source Y coordinate), SOU_ELEV (source absolute depth), 

REC_X (receiver X coordinate), REC_Y (receiver Y coordinate), REC_ELEV (receiver absolute depth), 

and CHAN (channel number). 

After adding these headers, the editor window should appear as shown below: 
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To import header values from a text file, select Tools → Import. The import setup dialog box 

will open. In this dialog, open the sp0_geom.txt file and specify the rules for completing the header 

fields. 
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The contents of the file will be displayed in the import window: 

 

There are two lists in the upper part of the window (both are still empty): Matching fields sets 
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the headers by which the program will match the data in the table with seismic traces, and Assign fields 

are the headers of which values will be assigned for the matched traces. We need to set both lists, and 

then assign each of the headers to their respective columns in the file. 

To set this up, first add the DEPTH field to the Matching Fields list (click Add and select it from 

the list). Next, add the fields SOU_X, SOU_Y, SOU_ELEV, REC_X, REC_Y, and REC_ELEV to the 

Assign Fields list. 

After that, specify which columns in the text file correspond to each of the fields listed above the 

Set column buttons. Tip: if you select the header field by left-clicking on it, then place the cursor in the 

correct column, left-click, and then click Set column, the column number will be filled in automatically. 

Finally, define the line range from which the program should read values using the Lines: From–

To parameters. An example of properly completed parameters is shown in the figure below. 

 

When importing header field values from a text file, the program performs the following steps: 

all fields used to identify traces (Matching Fields) and all fields to be updated (Assign Fields) are read 

from the specified columns of each text file line. The program then identifies all traces in the selected 

seismic dataset whose Matching Fields exactly correspond to the values in the line and assigns the other 

values from the line to the specified Assign Fields for these traces. 

Before importing the geometry, click Save Template… in the lower-right corner of the dialog 

box. In the new dialog, select My Borehole in the Location field and enter geometry_template as the 
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Object Name. This will save all selected header values to the database as a template. 

 

After saving the template, click OK in the Import Headers dialog box. Then, in the sp0_raw – 

Geometry Spreadsheet window, double-click the DEPTH field to sort the depths in ascending order. You 

will notice that each depth value is repeated three times, once for each channel. 

 

You can save the changes to the database by selecting Edit → Save Changes, or by clicking Yes 

when prompted to save changes upon exiting the Geometry Spreadsheet. 
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Data visualization (020 – view data) 

Create a new flow in the project tree and name it 020 – view data. 

This flow consists of two procedures: 

 

Trace Input 

In the module setup dialog, select the dataset sp0_raw. In the Sort Fields field, specify CHAN 

and DEPTH so that data are sorted first by channel number and then by depth within each channel. In 

the Selection field, enter *:* to read the entire data range for both headers. 
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Note 

Input VSP data may include components (X, Y, Z), control instrument readings, and auxiliary channels. This 

information is stored in headers such as CHAN and COMP. Typically, the X, Y, Z components can be selected by sorting 

the dataset. 

 

However, in some cases, sorting alone is insufficient. The Trace Header Math module can then be used to calculate 

header values using equations (see the RadExPro User Manual for a detailed description). 

 

For example, if channels 1–3 contain control instrument readings and the remaining channels contain X, Y, Z 

components, the following expression can be used to populate the COMP header with the X, Y, Z component indices (if not 

already assigned): 

 

comp = cond(chan > 3, fmod(chan-(3+1),3)+1, -1) 

 

Here, cond(c, x, y) returns x if the condition c is true, otherwise y, and fmod(x, y) returns the remainder of x 

divided by y. After applying this transformation, COMP = 1 corresponds to the X component, COMP = 2 corresponds to 

the Y component, COMP = 3 corresponds to the Z component. Subsequent flows and modules working with the X, Y, Z 

components will use the COMP header for sorting. 

 

In this simplified example, the first three channels correspond directly to X, Y, and Z components. From this point, 

the COMP header will be used for sorting the data. 

 

Screen Display 

The visualization parameters are shown below: 
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Click the Axis button to configure the axis parameters. 

 

To run the flow, select the Run menu command. The result should appear as shown below: 
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The data are now displayed sorted by channels (components). 

Picking P-wave first arrivals (030 – fbpick) 

Create a new 030-fbpick flow containing the following modules: 

 Trace Input 

 Resample 

 Trace Length 

 Screen Display 
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In the Trace Input module, configure the parameters as shown below. Sort by CHAN:DEPTH, 

as in the previous flow. Only the Z component is processed in this flow, which is achieved by limiting 

the selection to the third channel: enter 3:* in the Selection field. 

 

To improve the accuracy of first arrival times, resample the data to a smaller sample interval 

using the Resample module. In the module parameters dialog, set the New sample rate to 0.1. 



RadExPro seismic software    www.radexpro.com  

 

25 

 

 

Since only the first arrival times are of interest at this stage, limit the recording length to 2000 ms 

to speed up flow execution. Enter this value in the New trace length field of the Trace Length module. 

 

The final module in the flow is Screen Display, which allows interactive viewing of the first 

arrivals in the module window. Configure the module parameters as shown in the figure below. 

 

Click Run. The results of the flow execution are presented below: 
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For first arrival picking, adjust the image zoom using the Zoom menu item. Create a new pick by 

selecting Tools → Pick → New Pick (or press the hotkey N). Use Tools → Pick → Picking Parameters 

to set the picking parameters. 
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We will pick the trough of the wavelet in auto-tracing mode between the points. To do this, set 

the following picking parameters (detailed information on picking parameters and working with picks is 

available in the RadExPro User Manual): 

 

Perform picking of first arrivals as shown below (a zoomed-in window is shown as well): 

 

The auto-fill algorithm as configured above picks the first minimum of the wavelet. For the 

following flows, the pick needs to be exactly on the first arrival. To shift the pick from the minimum to 

the first break, hold Shift, right-click on the pick and drag a few milliseconds so that the pick is on the 

first arrival: 
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Use Tools → Pick → Save As to save the pick under the name fbpick on the second database 

level (SP0). In RadExPro, picks are normally tied to traces using two headers, which usually ensures a 

unique trace identification (for example, channel number and cable depth in VSP, or CMP number and 

offset in CMP seismic reflection surveys). 

In this case, however, we want the pick to be tied only to the cable depth so it can be applied to 

all components. For this, select DEPTH for both the left and right fields in the Pick Headers tab. 

 

Orienting towards the source point and picking S-wave first arrivals (040 – 3С 

orientation+S pick) 

A convenient method for more accurately determining first arrivals of P- and S-waves is to 

convert PM-VSP (polarization method) seismograms to the PRT system. In this system, the energy in 

the first-arrival window is maximized for the P-component, which orients this component towards the 

source and concentrates the P-wave energy on it. The R-component, perpendicular to P, contains the 

maximum of the S-wave energy, making it suitable for picking the downgoing and reflected S-waves. 

The T-component primarily contains noise and a small amount of residual wave energy. 

To convert a VSP seismogram to the PRT system and determine the S-wave first arrival times, 
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create a 3С Orientation+S pick flow. 

 

The flow consists of the following procedures: 

 Trace Input 

 SSAA 

 3C Orientation 

 Trace Output 

 Data Filter 

 Screen Display 

The main module of this flow, 3C Orientation, converts PM-VSP seismograms to the PRT system 

by maximizing the energy in the window containing the downgoing P-wave on the P-component. 

To perform the conversion, the module sequentially retrieves traces at the same depth from the 

X, Y, and Z components. The energy calculation window is specified in the module setup dialog and 

begins at the first arrival time of the P-wave for each trace, which should be recorded in the FBPICK 

header field. 

Before using the 3C Orientation module, include the Trace Input module (to provide properly 

sorted data) and the SSAA module (to transfer the first arrival pick to the FBPICK header) in the flow. 

After conversion, the seismic traces are saved to a new dataset, and the result is displayed on the screen. 

In the Trace Input module setup, select the sp0_raw dataset and sort by DEPTH:CHAN, as shown 

in the figure below. 



RadExPro seismic software    www.radexpro.com  

 

30 

 

 

The SSAA module calculates seismic attributes within a user-specified window along a given 

horizon and writes the results to seismic trace headers. In this example, the module is used to record first 

arrival picks from fbpick into the FBPICK header field for each trace. 

Select the Peak Amplitude Time attribute to be calculated and saved to FBPICK and set the 

window length to 0.0 to ensure the exact first break times to be saved to FBPICK. Select the fbpick 

horizon in the Horizon parameter. 

The module setup dialog should appear as shown below: 

 

In the 3C Orientation module setup, set the Window length to 10 ms. This defines the window 

(from the first arrival downward) inside which the energy is measured. The window length should match 

the P-wave first arrival wavelet length. A window that is too small may cause unstable results, while a 

window that is too large may include additional waves, such as reflections from adjacent boundaries or 

waves refracted at boundaries with mode conversion. 
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Leave all other parameters (XY Rotation, YZ Rotation, ZX Rotation) unchanged. These 

parameters, specified in degrees, allow additional rotation of the coordinate system in the respective 

directions. 

The module setup dialog box should appear as shown below: 

 

After running the procedure, traces with CHAN = 3 will contain the P-component, CHAN = 2 

will contain the R-component, and CHAN = 1 will contain the T-component. 

Next, add the Trace Output module to the flow to save the orientation results to the database on 

the SP0 level under the name sp0_PRT, as shown in the figure below: 

 

The remaining parameters ensure reliable display of results on the screen. The Data Filter module 

allows selecting traces based on header field values. In this example, we display each component 

separately. The figure below shows the module parameters configured to select only the R-component 

from the data: 
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The flow should end with the Screen Display module to visualize the data. Configure the module 

parameters as shown in the dialog box below: 

 

 

By changing the CHAN value in the Data Filter module, you can display the corresponding P, 

R, and T component images, as shown in the figures below: 
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CHAN=3 (P-component) 

 

CHAN=2 (R-component) 

 

  



RadExPro seismic software    www.radexpro.com  

 

34 

 

CHAN=1 (T-component) 

 

Next, use the PRT-oriented data to pick downgoing and reflected S-wave arrivals. 

To trace S-wave first arrivals, configure the Data Filter module to select only the R-component 

and display it in the Screen Display window. 

Pick the downgoing S-wave arrivals using the Tools → Pick menu commands, following the 

same procedure as for downgoing P-wave picking described earlier. The result is shown in the figure 

below: 
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Make sure that the S-wave pick is tied to cable depth (same as downgoing P-wave pick 

described above). Then save the pick under the S wave down going1 name: 

 

Using direct wave to determine the wavelet for deterministic deconvolution (050 – 

signature for deconvolution) 

Create a new 050 – signature for deconvolution flow containing the following modules: 

 Trace Input 

 Amplitude correction 

 Apply Statics 
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 Amplitude Correction 

 Screen Display 

 Ensemble Stack 

 Screen Display 

 Trace Output 

 

In this flow, a wavelet will be generated for use in the deterministic deconvolution procedure. To 

obtain the wavelet, the following preliminary steps are performed: apply a correction for spherical 

divergence, align the first arrivals using static corrections, and, if necessary, equalize amplitudes in 

regions where gain changes abruptly. After these corrections, all traces in the flow are summed in-phase 

to produce the wavelet estimate. 

First, create a flow with the following modules: 

 Trace Input 

 Amplitude correction 

 Apply Statics 

 Amplitude Correction 

 Screen Display 

Select the CHAN:DEPTH sorting in the Trace Input module parameters. In the Selection field, 

specify the 3:400-50000 selection range. The number 3 ensures that only the Z-component (traces with 

CHAN=3) will be processed. The depth range of 400- 50000 excludes the uppermost noisy traces (cable 
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depths up to 400 m) and extends beyond the maximum cable depth to include all relevant data. 

 

The Amplitude Correction module is used to correct for spherical divergence. Enable the 

corresponding option in the module dialog box as shown below: 

 

Next, use the Apply Statics module to introduce static shifts so that the direct wave occurs at the 

same time across all traces (100 ms in this example). The shift applied to each trace equals the difference 

between the P-wave arrival time recorded in fbpick and the specified constant time (100 ms). Configure 

the module parameters as shown in the figure below: 
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After applying the static shifts, equalize the trace amplitudes to compensate for intervals with 

substantially lower gain. Add another instance of the Amplitude Correction module to the flow and 

enable the Trace Equalization option within the 80–400 ms time window. 

 

View the results of the procedures using the Screen Display module, configured with the 

parameters shown below: 
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Run the flow. The result should look like the following: 

 

Next, sum the traces to obtain a seismic wavelet. Summation reinforces the in-phase direct wave 

while suppressing most other waves and noise. 

Comment out the Screen Display module and add the Ensemble Stack module to the flow. 

Configure the module parameters as shown below. The Alpha trimmed parameter removes the specified 

percentage of minimum and maximum amplitude values before summation, reducing the effect of high-
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amplitude bursts and noise. 

 

In RadExPro, traces are grouped into ensembles according to the first sorting field specified in 

the Trace Input module. In this case, this sorting field is the CHAN header. Since all traces in the flow 

have the same CHAN value (equal to 3), they will all be summed together during the execution of the 

Ensemble Stack module. 

Finally, the Trace Output module saves the resulting dataset to the database under the name 

sp0_decon_impulse. 

 

Next, the Screen Display module with parameters shown in the figure below is used to visualize 

the results. 
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Select the wiggle trace method for trace display (select WT/VA in the Display mode field). The 

Rotate option allows displaying the trace horizontally. 

Click the Axis button to configure the axis parameters: 

 

The resulting flow should look like the following: 
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Run the flow. The expected result is shown in the figure below. 

 

Looking at the stacked trace, we observe that the effective wavelet is about 80 ms long, with its 

origin around 100 ms. To check its frequency content, you can open the visualization window for the 

stacked trace and choose Tools → Spectrum → Average (hot key on toolbar ). With the tool active, 

drag with the left mouse button over the part of the trace you want to analyze. A pop-up window will 

appear showing the amplitude spectrum of the selected segment. 
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Testing deterministic deconvolution parameters (060 – deconvolution test.) 

Create a test flow titled 060-deconvolution. 

This flow will consist of the following modules: 

 Trace Input 

 Amplitude Correction 

 Custom Impulse Trace Transform 

 Screen Display  

 

Set the Trace Input module parameters as shown in the figure below: 
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Using the Amplitude Correction module, introduce the correction for spherical divergence  

(enable the Time raised to power option with a power of 1). 

 

Deterministic deconvolution can be performed using the Custom Impulse Trace Transform 

module. In the module parameters, specify the name of the wavelet dataset created during the previous 

step. In general, the trace with the wavelet should have the same sampling interval as the traces to which 

deconvolution will be applied. This is true, as in this case the wavelet was obtained directly from the 

dataset without any resampling. 

The module parameters are shown in the figure below: 
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To display the processing results on the screen, add the Screen Display module to the flow. 

Display the traces using the variable density method in grayscale palette (Grey) and set the number of 

traces on the screen equal to 300. 

 

To compare the deconvolution results with the original data, comment out the Custom Impulse 

Trace Transform module and run the flow. 

Before deconvolution, the data look like the following: 
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Now, without closing the Screen Display window, go back to the flow, uncomment the Custom 

Impulse Trace Transform module and run the flow once again. Another Screen Display window 

containing the deconvolution results will open: 

 

Now that the deconvolution flow has been completed, you can compare the input and output data 

directly. Open the visualization windows for both datasets and switch between them to see how the 
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deconvolution has sharpened the events. If you want to examine spectral changes, use the Tools → 

Spectrum → Average command in each window to display the amplitude spectrum of the selected 

records. For easier analysis, you can synchronize the windows using the “sight” icon on the quick access 

panel ( ) so that zoom, cursor position, and selected areas are aligned in both displays. 

Reflected PP wave field separation (070 – ug PP) 

Next, P-P reflected wave field needs to be separated for corridor trace computation. This wave 

field is estimated on the Z-component. In general, the procedure of reflected wave separation consists of 

picking a travel time curve for a noise wave (any wave other than the reflected one), flattening the noise 

wave using static corrections, subtracting this wave from the wave field using a two-dimensional spatial 

filter, and introducing inverse static corrections. 

Create a new flow for reflected wave field separation: 070 – ug PP. 

Let us analyze the input data first. To do this, construct a flow consisting of the following 

procedures: 

 Trace Input 

 Amplitude Correction 

 Screen Display 

The parameters are shown below. 

Trace Input 
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Amplitude Correction 

 

Screen Display 

 

The result of running this flow is shown in the following figure: 
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From the figure it is clear that the data contains different types of waves — downgoing and 

reflected P- and S-waves. It is also noticeable that the overall amplitude level varies from trace to trace: 

some traces show much lower gain than others. 

The first step is to equalize trace amplitudes using the Trace Equalization option of the Amplitude 

Correction module. This function computes the average amplitude for each trace within a chosen time 

window, then scales all samples of the trace by this average value. For this equalization to work correctly, 

the window must include events of the same type on all traces. 

In this case, we use the downgoing P-wave for balancing. To achieve that, we first apply static 

corrections to flatten the downgoing wave. Next, we perform amplitude equalization in the time window 

containing the direct wave. Finally, we restore the traces to their original timing by applying the inverse 

static corrections. 

Add the following modules to the flow: 

Apply Statics – select the fbpick first-arrival pick as the reference and set the correction to occur 

relative to the time of 100 ms. For each trace, the applied shift equals the difference between the picked 

P-wave arrival and this constant reference time. 
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Amplitude Correction – enable the Trace Equalization option. Set the time window so that it 

covers the downgoing P-wave, which will have been shifted to 100 ms after applying the static 

correction. The window should not be too narrow, otherwise the average amplitude calculation may 

become unstable. Configure the parameters as shown in the figure below. 

 

Add another instance of the Apply Statics module to introduce inverse static corrections. Its 

parameters should be the same as in the first instance, except for one difference: the Subtract static option 

needs to be enabled to introduce inverse static corrections: 
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At this stage, the flow should look like the following: 

 Trace Input 

 Amplitude Correction 

 Apply Statics 

 Amplitude Correction 

 Apply Statics 

 Screen Display 

The results of flow execution are shown in the figure below: 

 

That gain of different traces is equalized as a result of applying these procedures. 

Next, perform the deterministic deconvolution of the data with the parameters selected in the 

previous flow. The result is shown in the figure: 
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After deterministic deconvolution, the downgoing P-wave wavelet approaches a zero-phase 

shape. As a result, first arrival times now correspond to the wavelet’s central extremum rather than the 

initial zero crossing. Consequently, the first zero crossing is shifted to earlier times. Since this first arrival 

pick will later be used for muting, it must be adjusted to smaller times, as shown in the figure below, to 

preserve the wavelet shape during subsequent muting. 
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To adjust the first arrival pick, load the fbpick pick using Tools → Pick → Load pick. Move the 

pick to the desired location by holding Shift and pressing the right mouse button simultaneously. Save 

the modified pick under the name fbpick after deconvolution on the second database level. 

 

Next, the downgoing P-waves need to be removed from the record. To achieve this, the 

downgoing P-wave travel time curve must first be flattened using static corrections (Apply Statics). Then 

the wave is subtracted from the wave field using a two-dimensional spatial filter (2D Spatial Filtering), 

and finally, inverse static corrections are applied (Apply Statics). 

Add these procedures to the flow sequentially and observe the results after each step: 

Apply Statics: 

 

The result of applying the procedure is shown below: 
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2D Spatial Filtering: 

 

In the 2D Spatial Filtering module setup, select the subtraction mode (Filter mode: Subtraction). 

In this mode, the average value calculated within the window is subtracted from the central sample of 

the window. Choose the Alpha-Trimmed Mean filter type to minimize the effect of occasional high-

amplitude bursts on the result. 

The result of applying the procedure is shown below: 
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We can see that the downgoing P-wave was successfully subtracted from the record. 

Now, inverse static corrections are needed to return the remaining waves to their proper times. 

To do this, add another instance of the Apply Statics module to the flow: 

 

The result of running the procedures is shown below: 
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The processing flow should look like the following at this stage: 

 

Note that the data fragment circled in red in the figure below contains a low-frequency component 



RadExPro seismic software    www.radexpro.com  

 

57 

 

that is not present in the rest of the record. 

 

Therefore, before performing noise wave subtraction, it is necessary to apply band-pass filtering 

in the selected window. First, create a pick that outlines the area containing both the low- and high-

frequency components (as shown in the figure below). This pick will define the window for filtering. 

Save it under the name gate_for_filtering. Then apply the Time Variant Bandpass Filtering module, 

which performs band-pass filtering restricted to the specified window. 
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The pick divides the data into two windows, and we need to apply filtering only to the window 

which contains the low-frequency component. Open the Time Variant Bandpass Filtering module and 

set its parameters so that filtering is applied exclusively to the zone below the pick. Adjust the band-pass 

limits according to the figure below, leaving the fragment above the pick unchanged. 
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The gate_for_filtering pick defines the boundary between two processing windows. The 

parameters for both windows are written on one line, separated by a colon. For each window, set Window 

usage = 1 (filtering active). Then assign the pass band values: 4–6–250–250 Hz for the first window 

(before the pick) and 15–17–250–250 Hz for the second window (after the pick), exactly as shown in 

the figure. 

The result of applying the procedure is shown below: 

 

Now we proceed with subtracting the downgoing S-wave from the record, following the same 

method as used earlier for the P-wave. Because this wave is much slower, applying static corrections 

directly could cause data loss — useful signal samples might be shifted outside the trace range. 

To avoid this, first extend the trace length by inserting the Trace Length module into the flow 

and setting the new trace length to 9000 ms. 

 

After that, flatten the S-wave travel time curve at a time of 2500 ms, subtract  the wave, and 

introduce inverse static corrections. 

The resulting flow should look like the following at this stage: 



RadExPro seismic software    www.radexpro.com  

 

60 

 

 Trace Input 

 Amplitude Correction 

 Apply Statics 

 Amplitude Correction 

 Apply Statics 

 Custom Impulse Trace Transform 

 Apply Statics 

 2D Spatial Filtering 

 Apply Statics 

 Time Variant Bandpass Filtering 

 Trace Length 

 Apply Statics 

 2D Spatial Filtering 

 Apply Statics 

 Screen Display 

Parameters of the modules needed to subtract the S-wave are shown below: 

Apply Statics 
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2D Spatial Filtering 

 

Apply Statics 

 

The result of applying the procedures is shown in the figure below: 
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It can be observed that the wave field still contains some downgoing S-wave fragments after the 

downgoing S-wave subtraction. Perform the picking on one of such fragments as shown in the figure 

below. Save the pick on the second project level under the name S wave down going2. 

 

Use the same set of modules to subtract those fragments: Apply Statics (S wave down going2 

pick, Relative to time 4000), 2-D Spatial Filtering (filter type: Alpha-Trimmed Mean, window size: 9 

traces per sample, Subtraction mode), and another Apply Statics (same parameters as for the first one, 

but with Subtract Statics enabled). 

The result of applying the procedures is shown in the following figure: 
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Next, we introduce several “cosmetic” steps into the flow to improve the signal-to-noise ratio 

and ensure the reflection polarity is correct. Begin with the Burst Noise Removal module, which 

suppresses short, high-amplitude localized noise bursts. Configure the module according to the 

parameters shown in the figure below. 

 

The result of running the procedure is shown in the figure below: 
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Next, use the Bandpass Filtering module to apply band-pass filtering to the data in a wide 

frequency band. Select the Ormsby filter (Ormsby Bandpass Filter) with 5-10-70-150 Hz frequencies in 

the module parameters. 

 

To follow the polarity convention used in exploration seismology—where reflections from 

positive boundaries (an impedance increase downward) are displayed on Z-component seismograms as 

positive extrema—we need to invert the phase of the wave field. This is done by multiplying every trace 

by –1. Add the Trace Math module to the flow and set its parameters as shown in the figure: 
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Next, perform seismic trace muting before the first arrivals by running the Trace Editing with the 

parameters shown below. Use the first arrival pick shifted after deconvolution fbpick after deconvolution 

as the horizon defining the muting. 

 

The result of running the procedures is shown in the figure below: 

 

Finally, save the resulting reflected P-wave field to the database under the name 

sp0_Pwave_ug using the Trace Output module: 
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The resulting flow should look like the following: 

 Trace Input 

 Amplitude Correction 

 Apply Statics 

 Amplitude Correction 

 Apply Statics 

 Custom Impulse Trace Transform 

 Apply Statics 

 2D Spatial Filtering 

 Apply Statics 

 Time Variant Bandpass Filtering 

 Trace Length 

 Apply Statics 

 2D Spatial Filtering 

 Apply Statics 

 Apply Statics 

 2D Spatial Filtering 

 Apply Statics 

 Burst Noise Removal 

 Bandpass Filtering 

 Trace Math 

 Trace Editing 

 Trace Output 

 Screen Display 
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Note that the process of the reflected wave field separation may be improved by adding new 

procedures for the subtraction of remaining noise waves (such as S-waves with slightly different slope 

from the picked travel time curve). The process of reflected wave field separation can be iterative. 

Building a velocity model (080 – velocity model) 

Next, create a new flow to build a velocity model based on the separated reflected wave field – 

080 – velocity model. The flow will consist of the following modules: 

 Trace Input 

 SSAA 

 Advanced VSP Display 

 

In the Trace Input module, select the dataset created by the previous flow containing the reflected 

P-waves – sp0_P_wave_ug. Select one sorting key – DEPTH – and enter * in the Selection field to read 

the entire data range. 
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The actual velocity model building takes place in the Advanced VSP Display module. The 

seismogram input into the module should contain the downgoing P-wave first arrival times in the 

FBPICK header field. We use the SSAA module to copy those times from the fbpick pick. 

Select the Peak amplitude time attribute (time corresponding to the maximum amplitude in the 

window) on the first tab of the SSAA module dialog box. Since the exact pick time is needed, enter 0 in 

the Window length field (search window length). Select the FBPICK header field where the values will 

be written from the drop-down list on the right. Specify the fbpick first arrival pick as the Horizon in 

SSAA. 
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Now, add Advanced VSP Display to the flow. Select the following parameters: 

 

Specify the name of the file on the disk where the model will be automatically saved in the 

Save model file field. 

ATTENTION: After running the flow for the first time, it is recommended to specify the same model file name in the Load 

model file field as in the Save model file field. This will allow resuming the work from one run to the next. Besides, since the 

model output file is saved automatically when the user exits the Advanced VSP Display module, specifying it as the input 

file will help avoid undesirable loss of the previously created model. 

Run the flow. An Advanced VSP Display module window similar to the one shown below 

will appear: 
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Building the velocity model includes adding and editing layer boundaries. 

Editing layer boundaries 

Layer boundaries can be added, deleted or moved. 

 To add a layer boundary, place the mouse cursor over the spot in the seismogram 

window where you want to add a boundary and click the left mouse button. 

 To move a layer boundary, “grab” it using the left mouse button, drag the boundary 

to the new position, and release the mouse button. 

 To delete a boundary, double-click on it with the right mouse button. 

Adjusting the axes 

The scales of the depth, time and parameter axes can be changed. To adjust the scale, place the 

cursor over the start value of the axis, press the left mouse button, move the cursor to the new end value 

while holding down the mouse button, and release the mouse button. To revert to the original scale on 

the selected axis, right-click on the appropriate axis. 

The results of building the velocity model should look like the following: 
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These results can be exported to a text file using the File → Export result menu item. 

 

When you select this item, a dialog box will open, prompting you to specify the names of the text 

files where the results will be exported. 

 

Lay model file – file containing the layered velocity model 

Per-trace file – file containing the per-trace table with two-way vertical travel time curve values 

as well as average and layer velocity values. 
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Reflected wave field visualization and NMO-corrections (090 – ug and ug nmo waves 

display) 

 

Create a new flow and name it 090 – ug and ug nmo waves display. The flow will contain the 

following modules: 

 Trace Input 

 Amplitude Correction 

 Trace Editing 

 VSP NMO 

 Trace Length 

 Resample 

 Trace Output 

 Screen Display 

Specify the sp0_P_wave_ug dataset and sort by the DEPTH header in the Trace Input module. 
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Enable Automatic Gain Control in the Amplitude Correction module and set the operator length 

to 200 ms. 

Next, use the Trace Editing module to mute the record in the interval before downgoing P- wave 

first arrivals. Select the Top muting option in the module parameters and specify the fbpick after 

deconvolution pick as the horizon for muting. 

Use the VSP NMO module to introduce Normal Move-Out (NMO) corrections into the VSP data. 

The module parameters are shown in the figure: 

 

After that and before saving the result to the database and displaying it on the screen, revert to 

the original trace length – 4 s, which can be done with the help of the Trace Length module. 

 

Finally, using Trace Output, save the results to the sp0_ug_nmo dataset. 
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For visual quality control, insert the Screen Display module at the end of the flow with the 

following parameters: 

 

The result of running the flow is shown in the figure below: 
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Using two picks, select the window for corridor stack trace computation as shown in the figure 

below: 

 

Save the first arrival pick (shown in yellow in the figure) under the tw name, and the pick defining 

the end of the window used to build the corridor stack trace (shown in green in the figure) – under the 

cor summ name (save both picks to the second level of the project tree). 
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Building a corridor stack trace (100 – cor stack trace and 110 – cor sum) 

The corridor stack trace is created by stacking the data in the specified window along the first 

arrival travel time curve. Create a new flow and name it 100 – cor stack trace. 

 

The flow needs to contain the modules shown in the figure: 

 Trace Input 

 Trace Editing 

 Trace Editing 

 Ensemble Stack 

 Amplitude Correction 

 Trace Output 

 Screen Display 

This flow is designed to process the NMO-corrected reflected P-wave field. It applies top and 

bottom muting along the first arrival travel time curve, then stacks all traces to form a single trace, 

equalizes the amplitude along that trace, and saves the final result. 

The Ensemble Stack module performs stacking within ensembles defined by the first sorting key. 

Since in this case we need to sum all traces together, the first sorting key in the Trace Input module 

should be set to a header field that is guaranteed to have the same value for all traces. A suitable example 

is dt (the sampling interval). 
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The next two Trace Editing modules are used to perform top and bottom muting in sequence. Top 

muting is performed along the wt pick, bottom muting – along the cor_summ pick. 

 

 

Select the Alpha trimmed option in the Ensemble Stack module and set the trim threshold to 30%. 

This will eliminate the impact of noise bursts on the summation results: 
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Enable Automatic gain control in the Amplitude Correction module and set the operator length to 

1000 ms. 

 

Using the Trace Output module, save the resulting trace to a separate dataset named 

sp0_cor_stack.  

 

The Screen Display module at the end of the flow provides visual monitoring of the results. The 

result of running the flow is shown in the figure below: 



RadExPro seismic software    www.radexpro.com  

 

79 

 

 

The corridor stack trace we created will now be used for tying VSP data to surface seismic data. 

Since it is more convenient to perform the tie using a “pseudo-section” made up of multiple identical 

traces rather than a single trace, we will generate such a section in a new flow named 110 – cor sum. 

In the new flow, add several Trace Input modules, each of which will load the same corridor 

stack trace. Then use the Trace Header Math module to assign a unique index to the reflected wave field. 

This index will make it easier to distinguish between different data types when they are displayed 

together. Choose an unused integer-type header for this purpose; in this example, we set the value of the 

TRC_TYPE header to 2. 

 

Using the Trace Output module, save the result to a new dataset – sp0_cor_summ.  
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Insert the Screen Display module at the end of the flow to display the output dataset on the screen. 

The flow will look like the following: 

 

The “pseudo-section” generated by the flow may look like this: 
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Preparing VSP data for tying to seismic survey data (120 – ug vsp nmo waves for well 

tie and 130 – cor stack for well tie). 

Before tying VSP data (both reflected wave field and corridor stack trace) to land seismic survey 

data, we need to bring the VSP wave field as close to land seismic data in appearance as possible. This 

includes modifying the sampling interval, trace length and frequency content of the VSP traces to be 

similar to surface seismic data. 

To prepare the reflected wave field, create a flow and name it 120 - ug vsp nmo waves for well 

tie. The flow needs to contain the following modules: 

 Trace Input 

 Resample 

 Trace Length 

 Bandpass Filtering 
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 Trace Header Math 

 Trace Editing 

 Trace Output 

 Screen Display 

 

Load the reflected NMO-corrected P-wave field into the flow using the Trace Input module.  

 

Then resample the VSP data to a new sampling interval (the same as for the land seismic survey 

data – 2 ms) using the Resample module. 
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Next, set the trace length equal to 3700 ms using the Trace Length module. 

 

Next, use the Bandpass Filtering module to adjust the frequency content of the VSP data closer 

to that of the surface seismic. VSP usually has more high-frequency content when compared to surface 

seismic. Equalization of VSP and seismic data spectra helps ensure a more reliable tie. The filter 

parameters should be determined experimentally based on seismic data analysis. In this case, the 

following parameters are used: 

 

Use the Trace Header Math module to assign a unique index to the reflected wave field, which 

will help differentiate between various data types when visualized together. Select an unused integer-

type header; in this example, the TRC_TYPE header is set to a value of 3. 

Next, apply top muting with the Trace Editing module. Use the first arrival pick after NMO 

corrections (tw) as the horizon that defines the mute. 
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Finally, save the prepared data under the name sp0_ug_nmo_for_well_tie using Trace Output, 

and plot them on the screen using Screen Display. The result of running the flow is shown in the figure 

below: 

 

Preparation of the corridor stack trace section is performed in a similar manner in a separate flow 

named 130 – cor stack for well tie. This flow uses the same modules with identical parameters, except 

for three differences: the corridor stack trace is used as input, the TRC_TYPE header is set to 2 via the 

Trace Header Math module, and Trace Editing in not needed. Save the resulting dataset as 

sp0_cor_summ_for_WT. 
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Offset VSP processing 

The purpose of offset VSP processing is usually to separate the reflected P-wave field and build 

the migrated VSP and VSP-CMP sections. To process these data, create a second Area for the offset 

VSP shot point in the project database – SP1. The offset VSP data processing flow structure is shown 

below: 

 

As we can see from the flow structure and the names of the flows, offset VSP data processing 

before migration is done generally in the same way as zero-offset VSP data processing – data are loaded, 

first arrivals are picked, components are oriented, deconvolution parameters are tested, and the reflected 
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wave field is separated. The configuration of modules in the flows and their parameters are sometimes 

slightly different from those used in the previous case. Such changes are necessary due to specific 

properties of certain data, the nature of noise etc. However, the general processing logic remains the 

same, so we skip those flows in this section and leave it up to you to familiarize yourself with them. 

There are two significant changes in the 070 – ug PP flow. In this flow, the Burst Noise Removal is 

replaced by the TFD Noise Attenuation module, as it provides more accurate burst noise attenuation in 

this case with the following parameters: 

 

Also, we demonstrate an alternative to Apply Statics and 2D Spatial Filtering for the removal of 

unwanted parts of the wavefield. In this flow, after removing a couple of events with Apply Statics and 

2D Spatial Filtering, we completely remove all the remnants of the downgoing wavefield with the Reject 

positive wavenumbers option in the following F-K Filter. This only works on relatively unaliased data. 

Note that one can do a more accurate noise wave removal with this module by using polygons or fan 

filters (the details can be found in the RadExPro User Manual). 
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Next, we proceed to the 120 – migrations flow which is used to build migrated sections and VSP-

CMP sections. 

Building migrated VSP and VSP-CMP sections (080 – migrations) 

This flow consists of the following modules: 

 Trace Input 

 2D-3D VSP Migration 

 Screen Display 

First, use the Trace Input module to read the reflected P-wave field generated by the previous 

flows: 

 

Then, use the 2D-3D VSP Migration module. Depending on the parameters, it allows performing 

either migration or VSP-CMP transformation. 

Use the following parameters to obtain a migrated VSP section: 
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To obtain a VSP-CMP section, use the parameters shown in the figure below: 

 

Before running the migration, it might be necessary to edit the previously obtained (with 

Advanced VSP Display) My VSP P-Wave model.mdl velocity model file in the text editor of your choice. 

By default, the velocity model is built down to the deepest receiver. In order to enable the imaging below 

the deepest receiver, we need to extend the last layer of the model. In our case, we add 2000 m to the Z 

and Depth columns of the last boundary in the model, changing 2878.85 and 2920 m to 4878.85 and 

4920 m respectively. This allows us to include the maximum imaging depth of 4000 m. 
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The results of computing the migration and VSP-CDP transformation are shown below. 

Migration result: 
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VSP-CMP transformation result: 

 

Note. Data with properly assigned geometry as well as a correct velocity model are necessary for the 2D-3D VSP 

Migration module to run successfully. 

In addition to the 2D-3D VSP Migration, RadExPro has a new migration module, 

2D VSP/Crosswell Kirchhoff Depth Migration*. It can conduct Kirchoff migration for a variety of VSP 

geometries. This module is not limited to 1D velocity models provided by Advanced VSP Display and 

has some additional functionality for migration of downgoing wavefield and crosswell data migration. 

Flow 090 – migration demonstrates an application of 2D VSP/Crosswell Kirchhoff Depth 

Migration* to obtain a similar migration result to that displayed above. This is a standalone module, so 

it does not need any other modules in the flow. In contrast to 2D-3D VSP Migration, this module requires 

a manual setup of the binning line, so we create a line which starts in the middle between the source and 

the well and ends directly at well location with 10 m lateral spacing. This module computes the travel 

times for the type of waves being migrated. A dataset for these travel times is created with the name 

sp1_tt. In this case, we are using the same My VSP P-Wave model.mdl as previously, although a different 

velocity model can be used (for example, a 2D velocity obtained from other seismic methods). Other 

parameters are set up so that the result is similar to 2D-3D VSP Migration above, the details about the 

functionality of this module can be found in the User Manual. 

The parameters used in the project are as follows: 
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This is the migration result displayed by the flow 095 – migration plot: 
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Tying VSP data to seismic data (Well Tie) 

 

Loading seismic data into the project (010 – seismic data load) 

The flow consists of the following modules with parameters shown below: 

 Seg-Y Input 

 Trace Header Math 

 Trace Output 

The SEG-Y Input module loads seismic data into the project from a SEG-Y file: 
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Let us use the Trace Header Math module to assign a unique index to the seismic data. We will 

need this number to perform tying. Besides, since the DEPTH field is meaningless for seismic data, let 

us set its value equal to -1 (we will need it when printing the results in the 030 – plotting flow): 

 

Now, save the data to the project database using the Trace Output module: 
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Tying VSP data to CMP seismic reflection survey data (020 – well tie) 

The flow consists of the following modules: 

 Trace Input 

 Trace Input 

 Trace Header Math 

 Apply Statics 

 Trace Input 

 Ensemble Equalization 

 Trace Length 

 Trace Output 

 Screen Display 

Let us sequentially read the seismic data (seismic_data), the corridor stack dataset 

(sp0_cor_summ_ for_WT), and the NMO-corrected reflected wave field (sp0_ug_nmo_for_well_tie) 

using separate instances of the Trace Input module. Specify TRC_TYPE:DEPTH sorting for VSP data 

and TRC_TYPE:CDP sorting for seismic data. Specifying the TRC_TYPE header (where we have 

already entered a unique index for each data type) as the first sorting field allows the system to read every 

data type as a separate ensemble. 

Then, move to the Trace Header Math module and set the CDP header field value equal to -1 for 

VSP traces (we will need it when printing the results in the 030 – plotting flow). 

The next module in the flow – Apply Statics – allows introducing a bulk shift into the data by 

shifting the VSP data relative to the seismic data. Leave it commented out for now – we will need it later. 

Since VSP and seismic data may have (and do have) substantially different general gain levels, 

use the Ensemble Equalization module to equalize amplitudes between ensembles. The module 

parameters are shown below: 

 

These parameters mean that ensembles will be normalized by RMS amplitudes calculated for the 
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entire trace length (the window starts with 0 and ends with a value we know to be larger than the trace 

length). 

Then the data is trimmed to the length of 3500 (the Trace Length module), saved to the project 

database as a dataset named Tied_data (the Trace Output module), and output to the screen using the 

Screen Display module with the following parameters: 

 

The result of running the flow is shown in the figure below: 
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We can see that seismic and VSP data are shifted relative to each other. A constant shift needs to 

be introduced into the VSP data in order to tie them to the seismic data. To determine the shift, you can 

select the seismic data using the mouse and interactively move it up and down. 

To select a trace range, place the mouse cursor at the range start position above the traces, press 

the left mouse button, move the cursor to the end of the range while holding down the mouse button, and 

then release the mouse button. The selected area will be highlighted in an inverse color palette. The 

process of selecting seismic data with the help of the mouse in Screen Display is shown in the following 

figure: 
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Now “grab” the selected area with the left mouse button and move it down in such a way as to 

achieve the best possible match between reflections on seismic and VSP data. To make the comparison 

easier, the selected area will be once again displayed in its normal colors when you “grab” it: 
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After making sure that the reflections match, determine the shift amount by looking at the values 

displayed in the status bar. In this case the shift is equal to 100 ms. 

Now use the Apply Statics module to introduce this shift with the opposite sign into the VSP 

data: 

 

Running the flow with the Apply Statics module enabled should yield the following results: 
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Printing the processing results (030 – plotting) 

This flow is used to output the results of VSP and CMP data tie to any printer compatible with 

the Windows operating system or to a standard text or image file format: *.pdf, *.jpg, *.tif, *.bmp etc. 

The flow will consist of a single Plotting module (this is a so-called standalone module that 

generates the flow by itself). The module allows adjusting data visualization parameters (sorting, display 

method, scaling, amplification, pick and header plot printing, line width, font size etc.), printing text and 

graphic labels, and working with all standard print setup functions (including image preview before 

printing). 

Set the Plotting module parameters as shown below: 
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In the Dataset field, select the Tied_data dataset generated by the previous flow. In the Sort fields 

field, select the TRC_TYPE:DEPTH:CDP headers. The TRC_TYPE sorting key allows the system to 

read each data type as a separate ensemble and display data types in a certain order, i.e.: the seismic 

profile fragment (TRC_TYPE =1), the corridor stack dataset (TRC_TYPE =2), and the NMO- corrected 

reflected wave field (TRC_TYPE =3). The DEPTH sorting key allows us to achieve correct sorting of 

VSP data (this will not have any effect on seismic data since we have already set the value of this 

field equal to -1 for all seismic traces). The CDP key, in turn, ensures correct seismic data sorting and 

will have no effect on VSP data (since we have set the CDP field value equal to -1 for those data). To 

read all data, enter *:*:* in the Selection field. 

Set the visualization parameters Ensemble boundaries, Additional scalar, Display mode, 

Normalizing, Scales as shown in the figure. 

Use the General Layout... option to adjust label and margin parameters. Set the parameters as 

shown in the figure: 
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Using the T Axis... options, adjust the visualization and vertical axis title parameters as shown in 

the figure: 

 

Using the X Axis... options, adjust the visualization and horizontal axis parameters as shown in 

the figure: 
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Select the DEPTH and CDP header fields whose values will be displayed along the horizontal 

axis. We have set the tick step on the DEPTH axis equal to 200 and the tick step on the CDP axis equal 

to 10. This will result in DEPTH ticks being shown only for VSP traces (DEPTH= -1 for seismic data), 

and CDP ticks being shown only for seismic traces (CDP= -1 for VSP data). Set the grid line parameters, 

axis title and value mark fonts at your own discretion. 

Select the printing device in the Print setup... field. 

Use the Layout Preview... option to preview the image before printing. 
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If necessary, adjust the visualization parameters without closing the Layout preview window. 

Click the Update preview to redraw the preview window. 

When you are satisfied with all your settings, close the preview window and click OK in the 

module parameter dialog box. To start printing, run the flow using the Run menu command. 

The resulting project tree should look like the following: 
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